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Microsoft Office Word 2007

Introduction toWord

Microsoft OfficeWord 2007combines anew interface witlpowerful tools fortext and paragraph
formatting, as well as robust page layout options and graphics editingTtbsislocument introduces
you tosome of the essential concepts that will help you design effetdmemend in Word.

Getting Starting with Word

Opening the Program

To startWord, click on the Start Button, then point to Programs, and then click Microsoft Giocd
2007.Word opens withthe first page of aewdocumentvisible. The procedure for openingord
may vary depending on the setuptlué computeryou are using

The Word Environment

Notice inFigure 1 thelayout of the openingVord screenMany d the commonly usewordtools are
listed inFigure 1. You can easily find out the name ofitgm onthe Ribborby simplymovingthe
mousearrowover any iconrgot clicking the mouse buttogrfer a few seconds. A nanaad description
of the itam will appearin a screen tip

Office Button Quick Access Tabs Dialog box launcher
Toolbar
/ — ~ | _
(oF H 020 + Document2 - Microspft Word ~ x
e J Homjri Insert Page Layout References Mailings Review View gtStarted @
(| re2n — e i [ e e Find ~
e i Salioet Erady} " - [A &[] [3= - i= - |2 (8] M | asebcenc| AsbceDe AaBbCi AaBbCe ?Rl;,m .
| Paste 7 |B I U ~abex, x' Aa~||-A-| === EIE;HQ' i Normal |17 NoSpaci.. Headingl Heading2 - §t"f."s°e :Sdmv — Ribbon
= ‘ =T 7

| Clipboard ™ L Font P ! Paragraph |T| Styles iF] Editing J/
. K "g"jlz . 2 . S EEESRRERRRSY.
" N/
: Y

Group

|
Insertion
point
Document Status bar Viewing
information options Zoom
l Controls

Section:1 Page:1ofl | Words:0 | < English(us) | 23 | )
Figure 1: The opening screen of Word 2007 displaying a blank document.
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Creating a Document
Default Document Formatting

In Word 2007, fonts and spacing in newly created documents looks different than in previous versions
of Word (seeFigure 2). All new documents created in Word 2007 use e@sdibri 11 point or

Cambria 11 pointas the default font and also contain some extra pgvagand line spacing. The

spacing between lines has been changed from 1.0 to 1.15 and there is slightly more space between
paragraphshanks to a 10 point space after each paragrBpd Word 2007 default style set and fonts
were designed with escreen radability in mind Since many people email documents and create

PDFs, rather than print copies, the new defaults make it easier to read the documents on a computer

screen.

To change thdefault font and spacing for alew documents created in Word 2Q®allow these

steps:

1) Click the dialog box launcher in the lower right corner offbatgroup on théHometab.
2) Change the font, font style and size and clickeéault button in the lower left corner of the

dialog box.

3) Click theYesbutton when prompted to change all new documents to the new font settings.

N T = PN D R 1 3
DD LEdEH2 va )+ (s N = ™ 5 &

- Home | Insert | Page Lay | Referenc | Mailings | Review | View || Get Start,@) Home || Insert | Page Layo | Reference | Mailings | Review | View | Get Starte | ©

J .I:J 59 Web Layout 3 Q = — Times New Roman 12 =~ = Al &

i = [Z Outline — 23 ||[|B I U abe x, 3|4 I | s

Print |Full Screen _ Show/Hide | Zoom | Window  Macros Paste Fer > aragrap es iting
\Layout | Reading (=l Draft ¥ v = o F |2 A A | AW ¥ z v

Document Views Macros Clipboard Font i
2 | 3 | 4 ' : a J T 1 1 2 1 3 | 4 1

Onthe Insert tab, the galleriesinclude items that are designed ¢
3 look of your document. You can use these galleriesto inserttables, head
% and other document building blocks. When you create pictures, charts, ¢
coordinate with your currentdocumentlook.

You can easily change the formatting of selected text in the docu
for the selected text from the Quick Styles gallery on the Home tab. You
using the other controls on the Home tab. Most controls offera choice o
currenttheme or using a format that you specify directly.

To change the overall look of your document, choose new Them
tab. To change the looks available in the Quick Style gallery, use the Char

0 command. Both the Themes gallery and the Quick Styles gallery provide &

can always restore the look of your document to the original contained i 2 - '.
P Q
- ¥ ¥
[ | m D ] m [
Section:1  Page:iofl | |[EEIRIE =80 (0 U ()5 sectiom:1 Page:1of1 IEEEIERT - Te—v——0" |

On the Insert tab, the galleries include items that are designed t
: overall look of your document. You can use these galleries to insert tat
- cover pages, and other document building blocks. When you create pic
they also coordinate with your current document look.
You can easily change the formatting of selected text in the doc’
look for the selected text from the Quick Styles gallery on the Home tal
text directly by using the other controls on the Home tab. Most control
H the look from the current theme or using a format that you specify dire’
: To change the overall look of your document, choose new Ther§
i Layout tab. To change the looks available in the Quick Style gallery, u}
~ Quick Style Set command. Both the Themes gallery and the Quick Sty?
i commands so that you can always restore the look of your document t¢
your current template.

Figure 2: A side-by-side comparison of text in the Word 2007 default font format ( left) and in the Word 2003 default

format (right).
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To change the dault line spacing for athew documentsfollow these steps:

1) Click the dialog box launcher in the lower right corner of fagagraphgroup found on the
Hometab.

2) Change th&efore andAfter spacing to zero.

3) Change théine Spacingto Single and theAt: to blank.

4) Click theDefault buttonat the bottom of the dialog box.

5) Click theYesbutton when prompted to change all new documents to reflect the new spacing
settings.

Typing Text

The blinking vertical line located in the document isitigertion point. As you type, keyed text will
appear to the left of the insertion point. If you move the mouse, a pointer moves on screen. The pointer
can appear in several ways. Four of the most commamaswed in the table below

Pointer Description

1

When thepointer moves over the page, it looks like dream. When you click the mouse button
the insertion point is placeadto the document in the area where you clicked.

| —

When the pointer moves over specific formatting areas, the following icons appeathender
insertion point: align left, align right, center, left indent, left text wrap, and right text wrap. Thi
you type in that formatting area will appear in the format that corresponds to the icon

When the pointer moves over tRébon it takes tle shape of an arrow pointing up and to the le
Clicking the mouse button once over a command tab or command tab option will select that

A v

When the pointer moves past the left margin of the text on the page, it takes the shape of ar
pointingup and to the right. Clicking the mouse button at this point will select that line of text
select the entire paragraph, double click

Keep the following in minadvhen typing text

There are several ways to move around the documanting the arrows keys on the

keyboard, thé’age UmndPage Dowrkeys, or the scroll bars.

Use theTabkey, on the left side of the keyboard, to indent paragraphs (1 tab = 5 spaces). You
should not use the space bar to space out text. Learn to Usebtkesy and other methods in
Word, to control where text appears in the document.

Do notpress thé-nterkey on the keyboard at the end of each line. Only press Enter when you
would like to begin amewparagraphWord will use a feature called\ford Wrap to format

each line properly.

If you make a mistake entering text, accidentally delete all of your text, or just plain mess up,
you can click theJndo command on th@uick Access Toolbdsee Figure Lor use the

keyboard shortcuttrl+Z. See the related section under Hutinga Word Documertteading
below.

Red and/or green squiggly lines may appear under words as you type. Thestersial

spelling, grammar, punctuation, or spacing errors. See the related section uftiarid¢aeng a
Documentheading for information about fixing these errors.

St .
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Editing aWord Document

Once you have typed some textdcreated a Word documeryiou may want to edit your work by
adding, moving, or deleting text. Tresctioncoverssome of thdundamentakditing functions of
Word 2007

Selecting Text

Selecting text is a basic editing function used in Word. In most cases, text must be belece

can be formattedr moved There are several methods you can use to select text in Word. No one
method will work for every instance where you need to selectWsetthe option that is most
convenient for you or use the technique that besydits task

To select a wordsimply double clickit.

To select a paragraptuiple click it.

To select a sentence hold down @te key and left click anywhere in the sentence.

To select an entire line, click in the page margin to the left of the lie@ wWie pointetakes

the shape of an arrow pointing up and to the rigééFigure 3).

¢ To select the entire document click tHemetab, then th&electoption in theEditing group.
ChooseSelect All. Or, use the keyboard shortctifr|+A.

e Click at the beginning of the area (line, paragraph, etc.) where you want to select text. Hold
down theShift key and use the arrow keys to select an area ofRektase the Shift key when
finished.

e Hold down the left mouse button and drag across the area of text you want to select.

.E.

Onthe Insert tab, the galleriesinclude items that are designed to coordinate
your document. You can use these galleries to insert tables, headers, footers,

Figure 3: In the left margin, the pointer changes so you can select a line.

Adding/Removing Text

To addtext to an existing line, paragraph or page, follow these steps:
1) Click to place the insertion poimnt the position where you want to add text.
2) Type in the new text

To remove text from an existing line, paragraph or page, follow these steps:
1) Place thensertion point to the right of the text to be deleted
2) Press th&ackspac&ey as many times as needed.
- Or-
3) Place the insertion point to the left of the text to be deleted.
4) Press th®eletekey as many times as needed to remove text

Otherwise, youcan select a block of text apdessthe Deleteor Backspacdeys to remove the text or
simply begintyping to replacehetext.

St. Josephdés Coll ege 4
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Moving Text

There are two easy methods for moverdireblocks of text: using drddrop andusing cut/paste.
1) Select the texto be moved.
2) Click and hold thdeft mouse buttorver the selected text
3) Drag the text to the desired location. The insertion line will indicate where the text will be
dropped(seeFigure 4).
4) Releasghe mouse buttoto drop the text and the block is moved to the new location
(@) TIP: If you dropped the text in the wrong spase the Undo commandefer toUsing the Undo
Commandsectionon pages if necessary

Onthe Insert tab, the galleriesinclude items that are designed to coordinate with the overall look of
your document. You can use these galleries to insert tables, headers, footers, lists, cover pages, and
other documentbuilding blocks. When you create pictures, charts, or diagrams, theyalso coordinate
with your currentdocumentlook.

You can easily change the formatting of selected text in the documenttext by choosing a look for the
selected textfrom the Quick Styles gallery on the Home tab. You can also format text directly by using
the other controls onthe Home tab. Most controls offer a choice of using the look from the current
theme or using a format that you specify directly.

To change the overall look of your document, choose new Theme elements on the Page Layout tab. To
change the looks available in the Quick Style gallery, use the Change Current Quick Style Set command.
Both the Themes gallery and the Quick Styles gallery provide reset commands so that you can always
restore the look of your documentto the original contained in your currenttemplate.

g

Figure 4: Watch the insertion line in the document. Its position indicates where the text will
be moved.

Cut/Copy/Paste

The Cut, Copy, and Paste tools are used to rearrang@t@lijects)vithin your document. Text must
be selected before you can cut, copy, or paste it. For information on how to select 8gtestireg
Text Cut or opied text is automatically saved to the Clipboard (a special storage area).

Cuttingtext will remove it from the document and place it on the Clipbd@ogyingtext will allow it
to remain in the document unchanged while a duplicate copy is placed tine Glipboard. Text can
be pasted within the same document or into different documésiismay cut, copy, or paste as little
as one character of text or as much as an entire document.

To cut and paste text, follow these steps: = X

1) Select the text you wisio move. = e

2) On theHometab, in theClipboardgroup, clickCut (the scissors icoryr use the | paste
keyboard shortcuttrl+X. The text is removed from your document and placg

on theClipboard. Clipboard ™

3) Place the insertion point in the location where you would like to move the tefigure 5: The

4) On theHometab, in theClipboardgroup, clickPasteor use the keyboard gﬁﬁ%"gﬁﬁ?w
shortcutCtrl+V. The desired text is pasted to the selected location. Hometab.
St. Josephdés Coll ege 5
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To copy and pastext, follow these steps:
1) Select the text you wish to move.
2) On theHometab, in theClipboardgroup, clickCopy (the sheets of paper icool) use the
keyboard shortcuttr|+C. The text is copied and placed on the Clipboard.
3) Place the insertion point in th&cation where you would like to insert the copied text.
4) On theHometab, in theClipboardgroup, clickPasteor use the keyboard shortchirl+V. The
desired text is pasted to the selected location.

When you cut or copy text and then paste it intar ylmcumentyou can control the formatting applied
to the pasted selectionolyou want the text to lodke it did in its original location, or do you want it
to take on the look of the surrounding text where it is pasted? Sometimes you may wantooméapti
in another situation you may want the othter you paste text, a Smart Tag appears with formatting
options for that text; however, the tag will disappear when you begin typing mark tedessary,

click the small arrow next to the clipboambn and choose a pasting opti@eeFigure 6). The

options available will differ depending on the content of what is being pasted.

et commands so that you can always

ur current template.

{#)  Keep Source Formatting

() Match Destination Formatting
) Keep Text Only

Set Default Paste...

Figure 6: The paste smart tag controls the formatting of
the pasted text.

Using the Undo Command

If text was accidentally deleted or if there was some type of editing mistake)ayte able to
reverse the last action using tdiaedo command. If your last action cannot be reversed, the option will
read Cannot Undo.

Undo option
To undo your last action click théndo option on the Quick Access toolbar or \
use the keyboard shortodtrl+Z. Keep clicking the Undo arrow to undo each— v
previous actionTo quickly undo multiple actions, click the small down arro| (i = - O
foundto the right & the Undo option on the Quick Access toollelect the - Em
action(s) to unddérom the available list.

Figure 7: The Undo option on
. the Quick Access toolbar.
Find and Replace
Word'sFind and Replacefeaturesearclesyour documents for specific text, which can then be
highlighted, replaced with different text or formatting, or lefisag his feature is especially useful, for
example, if you must locaseword or phrase that is misspelled more than once in your éotwand
replace it with a corrected version.

St. Josephdés Coll ege 6
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To use the find and replace feature, follow these steps:
1) On theHometab, in theEditing group, clickReplaceor use the keyboard shortcotrl+H. The
Find and Replacdialog box appears, with thiReplaceab displayed.
2) In theFind whattext box, type the text you want to be replaced.
3) In theReplace withext box, type the text that you want to insert.
a. To set additional search optiofmatch casegind whole words only, etcglick inside the

Find whator Replace withext box anctlick theMore>> button.Check the boxes next to
the advanced option you want to apply.

Find | | coto |
Find what: lpictures LI
Replace with:  fimages ~]

More == I Replace Replace All l Find Mext I Cancel |

Figure 8: The Find and Replace dialog box in Word 2007.

4) To find the first occurrence of your text, clithe Find Next button.The first occurrence of the
text is highlightedThe appearance of your document may change as it moves to display the
highlighted itemThe highlighted text will be the first occurrence in the document after the
location of your insertiopoirt.

5) To replace the selected text, clitie Replacebutton.To leave this instance #sand proceed
to the next item, clickheFind Next button.The next occurrence is highlighted.

6) Repeat step 5 until you have replaced all desired occurrences.Wiidrhas shown you
every occurrence of the text, a dialog box will appear with the message "Word has finished
searching the document.”

7) To close thdé=ind and Replacéialog box, click theClosebutton.

) : .
(EZ TIP: Toreplace every occurrence of your text withskbwing you where the text was replacese
theReplace Allbutton in step 5 instead of the Replace butihen finished, aialog box appears
notifying you of how many instances of the text were replaced.

Saving the Document

To save your Word documeribllow these steps:

[ Da

1) Click theMicrosoft Office Button “* in the upper left corner of the program.

2) Click theSave Asoption in the Office Button menu.

3) Browse to a location to store the document using the options foundSavedarfield at the
top (sed~igure9)

4) In theSave as typgeld, choose a file format from the drop dolist (seeFigure 9).
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a. If you are planning on working with and viewing the document using a computer with
Word 2007, choose th&ord Document (*.docx) format
b. If you are planning on sending the document to someone who does not have Word 2007, or
viewing it on a computer thalbes not have Word 2007, choose\Werd 97-2003
Document(*.doc) format
c. If you want to send a needitable version of the document to someone \i@aé, choose
thePDF (*.pdf) format
5) In theFile namefield, enter a detailed file name. Do not use amgracters other than letters,
numbers, a hyphen, or an underscore.
6) Click theSavebutton when finished.

Saveas 21|
Save in: I‘Q My Documents 3 @ 3 X L j >
3, My Recent | Z)Excel Files:
Documents 4= pawerPaint Presentations

w Desktop ) Word Files

My

(& Documents

File name:  [File Name Here.docx |
Save as bype: IWord Document (*,docx) |v

yord Document (. docy -
\Word Macro-Enabled Document (*.docm) =7
\Waord 97-2003 Document (*.doc)

\Word Template (*.dotx)

\Word Macro-Enabled Template (*.dotm)

Word 97-2003 Template (*.dot) ¥

Figure 9: The top and bottom areas of the Save asdialog box in Word 2007.
(ﬁz TIP: For additional information on Microsoft Office 2007 File Compatibility, see the following web
site: http://tis.sjcny.edul/training/office2007.html

Opening a Saved Document
To open a previously sad Word document, follow these steps:

[ Oa
1) Click theMicrosoft Office Button “* in the upper left corner of the program.
2) Click theOpenoption in the Office Button menu.

3) Browse to a folder or drive location to open the Word document from using the options found
in theLookin field at the top.

4) When you locate the Word document you want to open, double click the file name.
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Formatting Text

You can format the text in yoWord documents by changing the font, size, color, character
formatting, and text alignmenAdditionally, you can borrow formatting from one area and reuse it in
anotherarea or insertysnbols, hyperlinks, and drop caip$o your documents.

Bold/ltalics/Underline

Three of the more commonly used font formatting options are bold, italics, and underline. There are
several ways to apply this formatting to selected text. Two of these methods are listed below: via the
options found on the Ribbon and by uskayboard shortcuts.
To format text using the options on the Ribbon, follow these steps:

1) Select the text to which you want to apply the formatting.

2) On theHometab, in theFontgroup, click the appropriate formatting choigsfor bold, | for

Italics, andU for Underline.
3) Formatting is applied to the selected text.

Clear formatting

Font face and

i v v
size : ° v lAx LT |
Times New Roman 12 A A=) Font color
~||ab? -
Bold, italics, __—¥ B 7 U -abe x, X Aa"||&- A
underline — =4 Dialog box
EoR - launcher

Figure 10: The Fontgroup on the Hometab.

To formattext using keyboard shortcuts, follow these steps:
1) Select the text to which you want to apply the formatting.
2) Use the following keyboard shortcut§:irl+B for bold, Ctrl+| for italics, andCtrl+U for
underline.
3) Formatting is applied to the selected text.

Font Face, Size and Other Formatting Options

TheFontgroup on theHometab contains other commonly used font formatting choices. This includes
the following: font face, size, strikethrough, subscript, superscript, change case, text highlight color,
ard font color. To apply any of these formatting optido#pw these steps:

1) Select text in the documetd which you want to apply N
formatti ng - Home | Insert Page Layout References Maili
2) Click the appropriate button in tintgroup.i OR =4 = PPt | =
3) To see even more font formatting options, click theodjal e [ anons —— ]
box launcher in the lower right corner of thentgroup. e ‘ur dgprey FB 5
Choose from among the many formatting options in the ‘ﬂr ALGERIAN
Font dialog box and click the OK button. : & Arial
: % Arial Black

‘ T Arial Narrow
i Arial Rounded MT Bold
T Arial Unicode MS

The font face drop down lisséeFigure 11) in theFontgroupuses | -
Live Previewenablingyouto see what the selected font looks likqg -
before you click to apply the choicgimply point to the font name] -

_ : - T Baskerville Old Face
and the selected text in the dogent shows a preview of the : it Batang

choice. : e

Figure 11: The font face drop down list.
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Text Alignment

Changing text alignment will affect the entire paragraph even if you have only a single word selected
or the insertion point placed in the paragraph. To format multiple paragraphs, you need to select at
least one character from each paragraph. You cam tahig with theeft or right margins, center the

text, or align the text wiih both margingjustify).

To change paragraph alignment, follow these steps:
1) If you want to align a single paragraph or line, click once inside the paragraph or line. If you
want to align multiple contiguous paragraphs or lines, select the text to be formatted.

2) On theHometab, in theParagraphgroup, click the appropriate text alignment butteee(
Figure 12).

Line Spacing

You can add space between lines within a paragraph by adjusting the line spacing. For example, you
may want your texsingle ordoublespacedTo add or adjust line spacing, follow these steps:

1) Place tke insertion point in the desired paragraplselect multiple contiguous paragraphs.

2) OntheHometab, in theParagraphgroup, clickLine Spacingandselect the desired line

spacingoption(1.0, 1.15, 1.5, 2.0, etcl) OR1T

3) On theHometab, in theParagraphgroup, click the dialog box launchéreeFigure 12).

4) Click thelndents and Spacingb.

5) From thelLine spacingoull-down menu, select the desd spacing.

6) Click the OK button.

Bullets and
numbering buttons

e gg »_;__:_:';,{Zlu q — Line spacing

===
= = E|,

Text alignment __—
buttons Paragraph —

Dialog box
launcher

Figure 12: The Paragraphgroup found on
the Hometab.

Paragraph Spacing

Instead oputting extra returns at the end of paragraphs, add additional space before and after
paragraphs by adjusting the paragraph spacing. This can be especially useful when you want the blank
line to be a different height from the teXb add or adjust paragra spacing, follow these steps:
1) Place the insertion point in the desired paragraph or select multiple contiguous paragraphs.
2) On theHometab, in theParagraphgroup, click the dialog box
launcher ¢eeFigure 12).
3) Click thelndents and Spacingb.
4) From theSpacingspin boxes, select the desired before dtet a
spacing ¢eeFigure 13). The adjustment is made to the white spate

before the first line and after the last line of the paragraph. Figure 13: The paragraph
5) Click the OK buton. spacing options.
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